


CONTENTS

Field of Application
Installation on Windows
Installation on Mac
Installation on Linux
Activation
How It Works

Workspace
Using the Program
Presets
Preferences
Print Image
Sand
Particles

Examples
Exploding Text
Splashes of Water
Golden Dust Effect
Summer Fantasy

AKVIS Programs

AKVIS Explosion

2



AKVIS EXPLOSION 2.0 | FABULOUS PARTICLE EXPLOSION EFFECTS

AKVIS Explosion adds destruction effects to your photo and applies dust and sand particles. With the software, you can
create eye-catching graphics in just a few minutes!

With Explosion, you can easily transform an image into a sandstorm or burst an object on your photo. Add spectacular
dispersion or pulverizing effects. Create a speed motion effect with a glowing trace. Apply magic whirlwind swirls to your
pictures!

The program explodes the selected part of your image and splits it up into a flying cloud of particles: grains of sand,
smithereens, splinters, etc. It offers an effective and entertaining way to achieve dust and sand effects on your images.
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With AKVIS Explosion, you can also make stylized images by adding leaf fall, snowfall, starfall, flying hearts or fluttering
butterflies, and other patterns. The program is equipped with an extensive texture library and offers the possibility to load
your own sample.

Create amazing media art, expressive illustrations, and catchy graphics! Add surreal effects to your casual photos!
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AKVIS Explosion is available as a standalone program and as a plugin filter for photo editors.

The plug-in is compatible with AliveColors, Adobe Photoshop, Corel PaintShop Pro, etc. See the compatibility page for details.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.

AKVIS Explosion

6



6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Explosion, in AliveColors: Effects -> AKVIS –> Explosion.

 

AKVIS Explosion

8



INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-explosion-app.dmg to install the Standalone version

- akvis-explosion-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Explosion application or AKVIS Explosion PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS Explosion app into the folder Applications (or any other place you
like).

To install the Plugin, drag the entire AKVIS Explosion PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> Explosion, in AliveColors: Effects -> AKVIS -> Explosion.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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INSTALLATION ON LINUX

Follow the instructions to install the AKVIS software on a Linux computer.

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using
the uname -srm command.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys: 

sudo mkdir -p /usr/share/keyrings
3. Download the key that signed the repository: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
or wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Add the repository to the list where the system looks for packages to install: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Update the list of known packages: 
sudo apt-get update

6. Install AKVIS Explosion 
sudo apt-get install akvis-explosion

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command: 
sudo apt-get upgrade

To remove the program: 
sudo apt-get remove akvis-explosion --autoremove

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository: 

sudo rpm --import https://akvis.com/akvis.asc
3. Add the repository to the system: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Update the package list:

when using the dnf package manager: 
sudo dnf update

when using the yum package manager: 
sudo yum update

5. Install AKVIS Explosion:

when using the dnf package manager: 
sudo dnf install akvis-explosion

when using the yum package manager: 
sudo yum install akvis-explosion

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager: 
sudo dnf upgrade

when using the yum package manager: 
sudo yum upgrade

8. To remove the program:

when using the dnf package manager: 
sudo dnf remove akvis-explosion

when using the yum package manager: 
sudo yum remove akvis-explosion
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Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository: 

rpm --import http://akvis.com/akvis.asc
4. Add the repository to the system: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Update the package list: 

zypper ref
6. Install AKVIS Explosion: 

zypper install akvis-explosion
7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates: 
zypper update

To remove the program: 
zypper remove akvis-explosion

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Explosion and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Explosion.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WORKSPACE

AKVIS Explosion can work independently as a standalone program or as a plug-in to a photo editor.

Standalone is an independent program. You can run it in the usual way.

Plugin is an add-on for graphics editors, for example for Photoshop, AliveColors, and other compatible programs. To call
the plugin, select it from filters of your image editing program.

 

When you start the program, you will see the Explosion effects thumbnails. Click to choose the effect.

 

The workspace will be arranged according to the interface mode: Express or Advanced. In Express mode, the program's
interface is extremely simplified and offers the minimal set of parameters and a full list of the ready-to-use presets.

AKVIS Explosion Workspace, Express Mode
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In Advanced mode, the full functionality of the program is accessible, with all tools and parameters.

AKVIS Explosion Workspace, Advanced Mode

 

Elements of the program window:

Most of Explosion's window is taken up by the Image Window with two tabs, Before and After. The original image is
displayed in the Before tab, and the After tab shows the result. You can switch between the windows by clicking on a tab
with the left mouse button.

In the upper part of the program's window you can see the Control Panel with the following buttons:

The button  opens the home page of AKVIS Explosion.

The button  (only in the standalone version) opens an image for processing. The hot-keys for the command are

Ctrl+O  on Windows, ⌘ +O  on Mac.

The button  (only in the standalone version) saves image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) opens the Print dialog. The hot-keys are Ctrl+P  on Windows, ⌘ +P

on Mac.
The button  imports a list of user presets (from a file with an .explosion extension).

The button  exports user presets. You can save any presets to an .explosion file, separately for each effect.

The button  loads selections made in the program (.stroke).

The button  saves selections to a .stroke file.

The button  /  shows and hides selections.

The button  cancels the last operation. It is possible to cancel several operations in a row. The hot-keys are

Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hot-keys

are Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  starts processing the image. Use hot-keys: Ctrl+R  on Windows, ⌘ +R  on Mac.

The button  (only in the plugin version) applies the result and closes the plugin.

The button  calls information about the program.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about the program.
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To the left of the Image Window is the Toolbar. The tools' parameters are shown in a pop-up box after right-clicking in the
image window.

 

Selection Tools

The button  activates the Selection Brush which is used to highlight areas of the effect. Adjust the tool's size in a

pop-up window which opens with a right mouse click in the image window. To get a straight line, draw a line while
holding down Shift .

The button  activates the Lasso tool that allows creating freehand selections. When you release the left mouse

button, the contour will be closed, the final point will be connected to the start one.
The button  activates the Eraser tool that lets you edit the selection. Adjust its size in a pop-up window.

The button  activates the Selection Bucket tool that can be used for selecting large areas. It fills an area outlined

with the Selection Brush. If the area was not circled by the brush, the entire image will be selected.

Hint: You can use Selection Bucket in the "eraser mode" to erase all selections at the image. Just click while
pressing Ctrl  on Windows, ⌘  on Mac.

The button  activates the Transform tool that helps to change the selection size and position.

 

Post-Processing Tools

The button  activates the History Brush which restores areas to their original state. The tool is available only for

the Home Deluxe and Business licenses.

Attention! Each time you start image processing , the result of using the tool is canceled. Apply it at the final

step.

 

Additional Tools

The button  activates the Hand tool which allows you to scroll the image when it does not fit within Image

Window at the desired scale. To use it click on the button, bring the cursor over the image, and while keeping the left
mouse button pressed move in the desired direction.
Double-clicking on the tool's icon  on the Toolbar makes the image fit the Image Window.

The button  activates the Zoom tool, which changes the image's scale. To zoom in left click on the image. To zoom

out left click with Alt  on the image. Press Z  to quickly access the tool.

Double-clicking on the tool's icon  on the Toolbar makes the image scale to 100% (actual size).

 

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is
visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the
visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

In addition, you can move the image in the Image Window using the scroll bar or by holding down the space bar, and then
holding down the left mouse button while moving the mouse. The mouse's scroll wheel can move the image up and down,
while holding Ctrl  on Windows, ⌘  on Mac – while moving the scroll wheel will move the image left and right. Holding Alt  on

Windows, Option  on Mac will scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider, to scale the image in the Image Window. When you move the slider to the right, the image scale increases.
When you move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some
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frequently used coefficients.

You can use hot-keys to change the image scale +  and Ctrl++  on Windows, ⌘ ++  on Mac to increase the image scale

and -  and Ctrl+-  on Windows, ⌘ +-  on Mac to reduce the scale.

 

Below the Navigator, there is the Settings Panel at the top of which you can see the effect control buttons:

The button  applies the current result to the Before tab. Above you can add new effects.

The button  removes effects from the Before tab, allowing to quickly return to the original image.

The button  shows/hides the background image. If the background is invisible, the effect is displayed on a

transparency.

Also, here you can choose the Effect and adjust its settings.

 

In the Presets field you can save the current settings as a preset to use them in the future.

Under the settings and presets you can see Hints for the parameters and buttons when you hover over them with the
cursor. You can choose where the hints will be shown or hide them in the program's preferences.
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HOW IT WORKS

AKVIS Explosion adds destruction and explosion effects to images. The software explodes the selected part of a photo and
splits it up into a flying cloud of particles: sand, smoke, smithereens, splinters, etc.

Follow these instructions to add an effect to an image:

Step 1. Load an image into the software.

- If you work with the standalone version:

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you
click on the button  on the Control Panel. You can also drag the required image into the workspace of the

program.

The standalone edition of AKVIS Explosion supports JPEG, WEBP, RAW, PNG, BMP, and TIFF file formats.

- If you work with the plug-in:

Open an image in your photo editor by calling the command File -> Open or using the key combination Ctrl+O

on Windows, ⌘ +O  on Mac.

Then call the AKVIS Explosion plugin in the Filter/Effects menu of the photo editor:

in AliveColors: Effects -> AKVIS -> Explosion; 
in Adobe Photoshop: Filter –> AKVIS –> Explosion; 
in Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Explosion; 
in Corel Photo-Paint: Effects -> AKVIS -> Explosion.

The Explosion workspace depends on the interface mode chosen in the Control Panel: Express or Advanced. The first
time the program is opened it will be in Express mode, with a simplified interface and a minimal set of sliders, which
help to quickly obtain a satisfactory result. Experienced users can switch to Advanced mode, the interface will
change, granting access to the full functionality of the program.

Original Photo

Step 2. Choose an Effect in the Settings Panel: Sand or Particles.
Step 3. With the selection tools, select areas where an effect will be applied.

Adjust the tool's parameters in a pop-up window which opens with a right mouse click in the image. To draw a straight
line use the Shift  key.
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Effect Area

It's possible to change the size and position of the selection with the Transform tool . Hold down the Shift  key

to maintain the object's proportions. Hold down Alt  to rotate the object by 5 degrees intervals or to scale it from its

center.

You can save the selection to a .stroke file with  and load with .

Step 4. By default, the Autorun Mode is enabled for instant displaying any changes. If this mode is disabled, start
image processing by clicking on . The result will be shown in the After tab.

Default Settings

Step 5. Adjust the effect's parameters in the Settings Panel.
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Step 6. You can combine different effects. Apply the result  sending it to the Before tab and explode the new area.

Changes will accumulate, creating a more fascinating effect.

Step 7. In the Home Deluxe and Business versions, you can edit the result using the History Brush . The tool lets

you modify the effect area or fade the effect restoring the image to its original state.

Attention! Each time you start image processing , the result of using the tool is canceled. To avoid losing

changes made with the brush, apply it at the final step.
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Sand Effect Using History Brush

Adjust the tool's parameters in the pop-up box that appears after a right click in the image window:

- Size (1-1000) changes the tool's diameter.

- Hardness (0-100%) defines the blurriness of the tool's edges. The less the value the more blurry the edges of
the brush are.

- Strength (1-100%) affects the degree of restoration to the original state.

Step 8. If you like your new settings of the effect, you can save them as a preset and use them in the future.

Learn more about the Explosion Presets.

Step 9. In the standalone version, you can also print your image with .

Step 10. Save the processed image.

- If you work with the standalone edition:

Click on the button  to open the Save As dialog box. Enter a name for the file, choose the format (TIFF,

BMP, JPEG, WEBP or PNG) and indicate the target folder.

You can save only the effect on a transparency: hide the background  and save the image as PNG.

- If you work with the plugin:

Press the button  to apply the result and close the plugin window. The AKVIS Explosion plugin will close and

the resized image will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.
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Result
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WORKING WITH PRESETS

AKVIS Explosion comes with a number of ready-to-use Presets for each effect. The AKVIS built-in presets help you start
working and learn how to use the program. You can modify the settings of the preset to achieve the desired result.

Each Explosion effect has its list of presets.

The program lets you add your own presets by saving your favorite combinations of the parameters. 
To create a preset, adjust the settings, type its name into the field, and press Save.

To return to the default settings of the selected preset, press Reset.

To delete your preset, choose it from the drop-down list and press Delete. The AKVIS built-in presets cannot be removed.

 

You can export your presets to an .explosion file, separately for each effect, with . To load presets from the file use 

.

Read more how to import and export user presets.
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PREFERENCES

Open the Preferences dialog by pressing on . The dialog window looks like this:

Language. Choose the program language in the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. The parameter defines the way the image is scaled in the main window after loading:

- Fit to View. The scale adjusts so that the image will be completely visible;

- 100%. The actual size is used, the image doesn't scale.

Recent Files (only in the standalone version). The number of recent documents. The list of the recent files, sorted by
time, become visible by right mouse clicking on . Maximum: 30 files.

Choose Effect on Start check-box. The option shows/hides the effect thumbnails when starting a program.
Autorun Mode check box. If this box is checked, any changes will be updated automatically.
If the option is not selected you must press the  button in order to see changes applied.

Selection Area. This parameter defines how the selection appears. Choose one of two variants:

- "Marching Ants". The selection is enclosed in borders that look like a "running" dashed line. This is the default
value.

- Filled with Color. The selection will be filled with a color.

By default, it is red. You can change it by double-clicking on the color plate.

The Opacity parameter allows you to adjust the opacity of the color used to highlight the selection.

Hints Panel. When you hover over parameters and buttons with the cursor you can see a brief description of them in
the Hints field. You can choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

History States (5-100). The size of the memory stack. It limits the number of the undo/redo steps (  and ).

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible.

To apply changes made in the Preferences window press OK.

If necessary, you can return to the default settings by pressing Default.
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PRINT IMAGES IN AKVIS EXPLOSION

In the standalone version of AKVIS Explosion you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Explosion

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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Effect Blend Mode: Normal Effect Blend Mode: Multiply

Angle = 25 Angle = 173

SAND

With the impressive Sand effect, you can burst an image and scatter it into grains of sand and dust.

Sand Effect

The effect allows you to deform the selected area. Use the selection tools: Selection Brush , Lasso , Eraser ,

Selection Bucket . The Transform tool  lets you change the selection size and position.

 

Effect Parameters:

In the Effect Blend Mode drop-down list, adjust how the effect interacts with the background. The program provides
9 blend modes.

Angle (-180...180). The direction of motion of the particles.

Dispersion (-5...30). The width of the scattering area of the particles.
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Dispersion = -5 Dispersion = 35

Waves Particles Smoke

Layer Blend Mode: Hard Light Effect Blend Mode: Hard Light

The effect is created by Waves, Particles, and Smoke. For Waves and Smoke, it's possible to adjust the transparency.

In the Layer Blend Mode drop-down list, adjust how the effect interacts with other effects in the intersection area.

Compare Layer Blend Mode and Effect Blend Mode (in both cases - Hard Light):

 

Waves Tab

Distance (10-300). The area of distribution of the effect.
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Distance = 25 Distance = 125

Waves Swirls Size = 10 Waves Swirls Size = 30

Blur = 20 Blur = 200

Fading = 20 Fading = 85

Waves Swirls Size (5-80). The amount of distortions in the sand streams.

Blur (7-250). The color smoothing effect.

Fading (0-90). Weakening the effect in the edges of the area.

Straighten check-box. When you turn on the checkbox, the waves are straightened.
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Straighten Check-Box Disabled Straighten Check-Box Enabled

Noise = 15 Noise = 100

Distance = 25 Distance = 125

Stretch = 10 Stretch = 30

Noise (0-100). Adding grain effect.

The Random Seed button generates a new distribution of the waves.

 

Particles Tab

Distance (10-300). The flight length of the particles.

Stretch (10-30). Stretching of the particles in the direction of the effect.

Particles Size (1-100). The size of the particles.
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Particles Size = 1 Particles Size = 50

Size Variation = 0 Size Variation = 80

Density = 20 Density = 40

Descending Size = 0 Descending Size = 90

Size Variation (0-80). The difference between the particle sizes.

Density (20-40). The number of the particles.

Descending Size (0-90). The reduction of the particles size at the edge of the effect area. At 0, all particles have the
same size.

The Random Seed button generates a new distribution of the particles.

 

Smoke Tab
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Distance = 15 Distance = 100

Distortion = 10 Distortion = 70

Blur = 15 Blur = 40

Smoke Swirls Size = 5 Smoke Swirls Size = 15

Distance (10-300). The area of distribution of the smoke.

Distortion (10-100). Deformation of the smoke trail.

Blur (15-50). The color smoothing effect.

Smoke Swirls Size (5-30). The amount of distortions in the smoke.

Darken (0-100). The higher the value, the more dark areas appear.
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Darken = 10 Darken = 80

Fading = 0 Fading = 90

Fading (0-90). Weakening the smoke effect at the edges of the area.

The Random Seed button generates a new distribution of the smoke.

 

PARTICLES
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PARTICLES

The fantastic Particles effect turns a selected part of an image into a sparkling cloud of flying particles.

Effect Blend Mode: Normal Effect Blend Mode: Color Dodge

Particles Explosion Effect

 

The effect allows you to deform the selected area. Use the selection tools: Selection Brush , Lasso , Eraser ,

Selection Bucket . The Transform tool  lets you change the selection size and position.

 

Effect Parameters:

In the Effect Blend Mode drop-down list, adjust how the effect interacts with the background. The program provides
9 blend modes.

Angle (-180...180). The direction of motion of the particles (excluding the wind effect).
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Angle = -153 Angle = 5

Without Wind
(Check-Box Disabled)

Wind Effect
(Check-Box Enabled)

Wind Direction = -55 Wind Direction = 135

Selections Normal Mode
(Check-Box Disabled)

Step by Step Mode
(Check-Box Enabled)

Wind Effect check-box. When you turn on the check-box, the particles are moved by the wind (see the Wind tab).

Wind Direction (-180...180). The deviation angle of the flying particles.

Step by Step check-box. In this mode, each selected area is destroyed independently of the others, forming more
particles (in this case, processing will be slower).

In the Layer Blend Mode drop-down list, adjust how the effect interacts with other effects in the intersection area.

Compare Layer Blend Mode and Effect Blend Mode (in both cases - Color Dodge):
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Layer Blend Mode: Color Dodge Effect Blend Mode: Color Dodge

Size = 5 Size = 50

Distance = 150 Distance = 500

Density = 100 Density = 700

Particles Tab

Size (5-100). The size of the particles.

Distance (100-3000). The flight length of the particles.

Density (15-800). The number of the particles.

Rotation (-180..180). The rotation of the particles around their axis.
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Rotation = 0 Rotation = 40

Dispersion = 0 Dispersion = 30

Descending Size = 0 Descending Size = 100

Texture Blend Mode: Normal Texture Blend Mode: Color Dodge

Dispersion (0-60). The width of the scattering area of the particles.

Descending Size (0-100). The reduction of the particles size at the edge of the effect area. At 0, all particles have
the same size.

Texture Tab

In the Texture Blend Mode drop-down list, choose how the particles interact with each other.

Select the shape of the particles from the built-in samples (circle, square, heart, etc.) or upload your own sample.
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Triangles Stars

Texture Filled with Object's Colors Texture Filled with Yellow

Motion Blur = 2 Motion Blur = 10

Strength = 500 Strength = 2500

The texture of the particles is generated in two ways:

From Image. The particles are represented as broken pieces of the original image of the selected shape.

Use Color. The particles will be recolored with the selected color.

Motion Blur (0-50). The strength of the Motion Blur effect.

Wind Tab

Strength (10-3000). The intensity of the wind.

Fading (0-100). The area of weakening the wind. At 0, there is no weakening; at 100, it is maximum.
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Fading = 0 Fading = 100

Turbulence = 200 Turbulence = 3200

Diversity = 5 Diversity = 20

Size Variation = 0 Size Variation = 70

Turbulence (0-3000). The dispersion of the stream of the particles along the wind direction.

Diversity (5-20). The alternation of sparse and concentrated areas. It works when the Turbulence is above 0.

Variations Tab

Size Variation (0-70). The difference between the particles sizes.

Rotation Variation (0-180). The difference in the rotation angle of the particles.

AKVIS Explosion

41



Rotation Variation = 0 Rotation Variation = 70

Aspect Variation = 0 Aspect Variation = 60

Hue Variation = 0 Hue Variation = 125

Saturation Variation = 0 Saturation Variation = 30

Aspect Variation (0-60). The difference in the particles compression ratios.

Hue Variation (0-125). The range of color shades.

Saturation Variation (0-30). The range of color saturation.

Brightness Variation (0-30). The range of color brightness.

AKVIS Explosion

42



Brightness Variation = 0 Brightness Variation = 30

The Random Seed button generates a new distribution of the particles in the destroyed area.
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EXPLODING TEXT

In AKVIS Explosion, it's easy to create the effect of partial destruction of text.

Step 1. Run the program and open an image with text.

Image in AKVIS Explosion

Step 2. Use the Selection Brush  to select the edges of the letters.
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Selection

Step 3. Choose the Sand effect, change the angle, distance and size of particles. Run image processing with .

Sand Effect Settings

Step 4. Change the Effect Blend Mode to Screen or Color Dodge so that the particles would not cover the front of
the letters.
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Effect Blend Mode (Screen)

Step 5. Save the image .

Take a look at other examples of the text explosion:
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SPLASHES OF WATER

Another fun use of AKVIS Explosion is creating water splashes using the Particles in the form of bubbles. This effect lets
you artistically modify photographs of people or objects in water.

Original Image Splashes of Water

Step 1. Run the program and open an image in the Particles effect.

Image in AKVIS Explosion

Step 2. Use the Selection Brush  to select a small area in the water next to the subject. Save the selection to a

.stroke file with . From here splashes are generated.
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Selection

Step 3. Set the Angle and adjust the parameters in the Particles tab. You can use one of the ready presets.

Image processing starts automatically.

Particles Effect Parameters

Control the shape and direction of splashes with the Wind Effect.
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Wind Effect in Action

Step 4. Change the Effect Blend Mode to Lighten and apply the result to the Before tab by clicking on .

First Application of The Effect (Before Tab)

Step 5. Sometimes to achieve the desired effect, we have to combine multiple results.

Load the previously saved selection  and change or move it a bit with .

Adjust the parameters of the effect (for example, the size and direction of the particles). The new splashes will be
placed above the previous ones.

Select the Layer Blend Mode (we use Soft Light) and apply the changes .
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Adding More Splashes

Step 6. In the last step, you can refine the result with the History Brush  (edit or fade the effect).

Refinement with the History Brush

Step 7. Save the image  and keep experimenting!
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Water Splashes with Particles Explosion Effect

Here are some more examples of creating water splashes:
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GOLDEN DUST EFFECT

Using AKVIS Explosion, you can easily apply various destruction and dispersion effects to digital photos. For example, you
can use the Sand effect to add some golden dust to an object.

Golden Dust Effect
(open a larger version)

Step 1. Launch AKVIS Explosion, select the Sand effect, and open an image using .

Image in AKVIS Explosion

Step 2. Create a selection using the Selection Brush . If the Autorun Mode mode is enabled, the image is

processed automatically. If the mode is disabled, click on  to run the processing.
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Selection

Step 3. Adjust the effect parameters. Choose Linear Dodge for the Effect Blend Mode.

First Result

Save the first result by clicking on . Then re-open it in the program by clicking on .

Step 4. Re-process the image using another settings. To do this, you must firstly create a selection. Adjust the
parameters. Choose Normal for the Effect Blend Mode.

You can experiment with different blend modes and combine different settings until you get a result you like.
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Final Result

Step 5. Save the image by pressing  and enjoy the creative design!
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SUMMER FANTASY

You can use AKVIS Explosion not only to destroy images but also to create impressive fantasy effects.

Original Image Result

Step 1. Run the Explosion program, select the Particles effect, and load an image.

Image in AKVIS Explosion

Step 2. The first thing to get started is to create a selection. Using the Selection Brush , highlight an area to

process.

If you work in the Autorun mode, a scattering cloud of particles will immediately appear near the selection. If the
automatic mode is disabled in the preferences, the result will only appear after clicking on .
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Selection

Step 3. Since we have three selected areas, enable the Step by Step check-box to generate more particles.

Step by Step Mode

You can use any shape for the particles - for example, butterflies to emphasize the summer mood of the picture.
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Choosing Pattern

Step 4. If you want to continue experimenting with the effect, switch to the Advanced mode and adjust the
parameters or use the AKVIS ready-to-use presets.

Step 5. Save the image  and enjoy the fascinating picture you made!
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Result
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
quality of compressed images. This program provides 4 image enhancement modes, each involves a unique neural network
developed especially for this occasion. The software is available free of charge for home users. For commercial use, a
Business license is offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…

AKVIS Explosion

62

https://akvis.com/en/airbrush/index.php?utm_source=help
https://akvis.com/en/airbrush/index.php?utm_source=help
https://akvis.com/en/airbrush/index.php?utm_source=help
https://akvis.com/en/artifact-remover/index.php?utm_source=help
https://akvis.com/en/artifact-remover/index.php?utm_source=help
https://akvis.com/en/artifact-remover/index.php?utm_source=help
https://akvis.com/en/artsuite/index.php?utm_source=help
https://akvis.com/en/artsuite/index.php?utm_source=help


 

AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any
picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage AI — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style
of a selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load
a custom sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…
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AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…

 

AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…

AKVIS Explosion

70

https://akvis.com/en/pastel/index.php?utm_source=help
https://akvis.com/en/points/index.php?utm_source=help
https://akvis.com/en/points/index.php?utm_source=help
https://akvis.com/en/points/index.php?utm_source=help
https://akvis.com/en/refocus/index.php?utm_source=help
https://akvis.com/en/refocus/index.php?utm_source=help
https://akvis.com/en/refocus/index.php?utm_source=help
https://akvis.com/en/retoucher/index.php?utm_source=help
https://akvis.com/en/retoucher/index.php?utm_source=help


 

AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…
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AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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